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1. Single High-Speed Capture 

For installation details please refer to Tutorial 6a – High-Speed Camera Set-up. 

Once you have completed the install procedure, double click on the Quintic software 

icon on the computer’s desktop to open the Quintic software. Click on the ‘Camera’ tab 

in the Main window and select ‘High Speed Capture’ then ‘Single’.  

 

 

 

 

A pop up saying, ‘Please Install latest USB updates’ will appear, please click OK.  

 

 

 

 

The camera window will open in standby mode.   

 

 

 

 

 

 

 

(The high-speed camera interface window in standby mode) 



 

 

To start the live camera preview, click on the       button. A live preview will now load if 

you only have one Quintic Camera plugged in. If you have more than one Quintic 

Camera plugged in, you will have to choose which camera you would like to open.    

 

 

 

 

 

 

Displays the current 

video resolution 

Information on how 

many frames are being 

delivered and dropped 

Displays the video 

capture speed 



 

 

a. Camera Parameters 
 
To change the camera parameters, click on the      button or select the ‘Camera’ 
tab and then the ‘properties’ option from the drop-down menu. This will open the 
properties window.   
 

 

 

 

 

 

 

 

 

 

 

Parameters can be saved as an .ini cam file so that various frame rate, resolution 

settings etc can be saved for ease of use. 

 

 

 



 

 

b. Camera Tab (frame rate & exposure) 

The camera tab allows the pixel clock frequency, frame rate and exposure time to be 

altered.   

Firstly, check the ‘Optimum’ box. This will allow the software to run at the optimal Pixel 

Clock Rate. This will improve/increase the maximum frame rate at which the camera can 

capture at. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

Timing 

Camera Peak Bandwidth is the maximum required bandwidth in MB/sec (Peak). If the 

bandwidth exceeds this, it is displayed in red.  

Camera Average Bandwidth is the average bandwidth required in MB/sec. If the 

bandwidth exceeds this, it is displayed in red.  

N.B. Make sure that these values don’t exceed the bandwidth limit, otherwise 

performance will be impaired. You are able to ensure the bandwidth is not exceeded by 

adjusting the parameters below. 

Pixel Clock 

Sets the clock rate at which the image data is read from the sensor. Altering this setting 

affects frame rate and exposure time. 

Frame Rate 

Depending on your bandwidth value, there are varying maximum amounts of frames per 

second that can be captured. This value will decrease as the resolution value increases. 

When setting the frame rate in freerun mode, the camera will capture one image after 

another at the set frame rate.   

Hold: When this check box is selected the frame rate will remain at the set rate, if the 

pixel clock changes.  

Max: when this box is selected the camera will record at the maximum rate that is 

possible. Frame rate depends on the capture resolution and the pixel clock.  

Auto: This option selects the Auto Frame Rate Function. This is only available when 

Auto Exposure is selected.  

Frame rate will change when the user sets a new area of interest (AOI) of image. 

Utilising the highest frame rate possible is especially important when capturing fast 

movements (e.g. the golf swing). A typical golf swing can occur at 100mph or 150ft/sec, 

so if your camera is sampling at 30Hz the club will move 5 feet per 1/30 of a second.   



 

 

In order to ensure that all actions are accounted for, you must sample quickly, otherwise 

the subtle movements will be lost.  

Exposure Time 

This is the amount of time the shutter remains open to allow light into the sensor in order 

to form an image.  

This option sets the exposure time. The available exposure time depends on the pixel 

clock setting and the frame rate. A low frame rate setting allows long exposure times, 

where as a high frame rate reduces the maximum possible exposure time.  

Hold: When the check box is selected the exposure will remain at the desired setting if 

the frame rate changes.  

Max: The camera runs at the maximum exposure time that is possible at the current 

frame rate.  

Auto: this option selects the Auto Exposure Function. The exposure time changes 

automatically depending on the selected frame rate.  

See the table below which illustrates exposure time and shutter speed settings. As the 

shutter speed increases, the exposure time decreases as the image is exposed to light 

for a shorter period of time. As the shutter speed decreases, the exposure time 

increases as the image is exposed to light for a longer period of time.  

 

 

 

 

 

 

 



 

 

c. Image Tab (gain boost) 

In digital imaging a voltage proportional to the amount of incident light is output at the 

sensor. To increase image brightness and contrast, this signal can be amplified by an 

analogue gain and offset before the digitising process.  

Analogue amplification of the read-out pixel values increases overall image brightness 

and contrast, allowing for a lower exposure value/higher shutter speed to be applied.  

Click on the ‘Gain Boost’ option within the Image tab, to automatically increase the 

brightness and contrast of the image.  

 

 



 

 

d. Size Tab (video size, area of interest) 

On this tab, the user can set the image size parameters for their camera. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Area of Interest (AOI) 

The area of interest function allows the user to concentrate the camera on the action 

they wish to film by altering the resolution the camera captures at. These parameters 

allow the user to select the size and position of the Area of Interest (AOI). AOI sets the 

camera so that only data included within the specific area is captured. Using the AOI 

function to create a smaller resolution also enables the camera to capture at a higher 

frame rate. To change this, go back to the camera tab after altering the AOI.  



 

 

Selecting the ‘Show Only AOI’ box sets the camera preview to only display the AOI, 

without a black border. This function saves memory and processing time when 

rendering the image and ensures the video is recorded with no unwanted black borders.   

Width/Height  

Sets the AOI width and height.  

Left 

Sets the left-hand edge position of the AOI.  

(Selecting the ‘Centre’ box centres the AOI horizontally).  

Top 

Sets the top edge position of the AOI.   

(Selecting the ‘Centre’ box centres the AOI vertically). 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

e. Other Functions 

Set New AOI 

An alternative to setting the AOI in the size tab, is the Set AOI function.  

 

To use the AOI function, select ‘Set  

New AOI’ from the camera tab or  

click on the ‘Set New AOI’ button on  

the toolbar. The original preview is 1280 x 

1024 resolution and capturing at a max 

frame rate of 60fps. 

 

 

To set the area of interest click and hold  

the left mouse button down, and drag  

over the desired area you wish to set  

as the AOI. A white grid will illustrate  

the selected area. 

 

 

 

 Only the AOI is now shown on the 

 preview screen and will be captured.  

 The new video resolution is 468 x 

 234 and the maximum recording 

 speed is now 238fps. 

 

 



 

 

Image Preview Controls 

The user can control the size of the video preview screen by clicking on the ‘View’ tab 

and selecting render or by using the display function buttons located on the menu. 

 

 

Disable the video preview 

To disable the camera preview, click on the     button. This will disable the preview 

screen.  

Enable full screen video preview 

To enable a full screen preview, click on the   button. To exit out of full screen 

mode click on the ‘Esc’ button.  

N.B. in order to use this function Direct X 3D may need to be installed.  

Scale the video preview to the window size  

To fit the preview video to the open window, click on the            button. This will scale the 

open video preview to the current window size. 

Scaling the display 

The preview display can be scaled down to ¼ of the original size or up to twice the 

original display size.   

 Displays the video preview at original size                                            

  Scales the video preview to half size  

  Scales the video preview to quarter size  

 Scales the video preview to double size  

 

 

 

 

 



 

 

Drawing tools 

When using the preview screen, drawing tools can be used to highlight key areas on the 

screen, although these shapes and lines won’t be saved to the video. Draw any of the 

shapes by clicking on the shape button you require, moving the cursor over the screen 

to where you want the shape to be, then holding down the left mouse button and 

dragging the shape across the screen. To add text to the video preview screen, click on 

the area of the screen where you want the text to appear and use the keyboard to type 

the desired text. 

 

Screenshot 

When using the preview screen, a screenshot can be captured and exported into 

another program. To export a screenshot, click on the           button - this will save a 

copy of the frame to the internal memory. To export the screenshot into another 

program, click on the paste function or press the Ctrl button + the ‘V’ button.  

Display Rate 

The video frame rate can be limited to 30fps. To set the display rate to 30fps click on the         

  button. 

Standby / close camera 

To close or set the camera on to standby mode click on the        button. 

 

 

 

 

Circle Drawing Tool 

Freehand Drawing Tool 

Straight Line Drawing Tool Rectangle Drawing Tool 

Eraser Tool 

Text Tool Measuring Tool 



 

 

f. Saving Camera Parameters 

Once you have the correct area of interest, frame rate and other parameters setup for that 

specific camera, the parameters need to be saved.  

This can be done by going to ‘File’ then ‘Save Parameters’ then ‘to File’ 

 

 

 

 

 

 

 

This will create an *.ini file.  

Save this file onto the desktop or in a folder on the C drive. 

NB: Cannot save directly to ‘Program Files (x86)’.  

g. Loading Camera parameters 

To load previously saved Camera Parameters within the Single High Speed Capture 

window, simply go to File, then ‘Load Parameters’ then ‘From File’.  

Simply locate the Cam File you would like to use and open it. This will then load your 

already pre set camera parameters, such as AOI, Frame Rate, Exposure Time etc to the 

camera that is currently open.  

 

 

 

 

 

 



 

 

h. Cam Files 

In order for your Camera Parameters to function correctly within Quintic software, there are 

certain characteristics within the Cam file (.ini file) that have to be present. These are as 

follows: 

• Start x absolute = 0 

• Start y absolute = 0 

• Offset divisible by 4 

• Width divisible by 8 

• Colormode = 6 

 

It is possible to open and amend the .ini cam files within Notepad if necessary.  

To check that your cam file has the correct characteristics, please open the .ini cam file. 

This will open the cam file in Notepad.  

Please find the characteristics mentioned above and ensure that they are correct. If not, 

please alter the cam file accordingly by simply editing the text.  

Once altered, please press Ctrl + S to save the cam file settings. Alternatively, press ‘file’ 

then ‘save’.  

NB: Cannot save directly to ‘Program Files (x86)’. 

NB: It is not recommended to alter the Width, Height or the offset in the ini cam file. We 

would recommend altering this within the Single High-Speed Capture software so that the 

frame rate is automatically calculated and is achievable.  

 

 

 

 

 

 

 

 

 

 



 

 

i. Using the Camera 

To start capturing video footage, click on the            button or select the ‘File’ tab from 

the menu bar and then select ‘record a video sequence’ from the drop down menu. 

Once selected, the Record dialog window will open. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Before recording a video click on the ‘Create’ button. This will load the ‘Save As’ 

window. Select the file directory where you wish to save your video and also type a file 

name and then select ‘Save’. 

To start capturing video footage, click on the ‘Record’ button. The software will now 

capture video until the ‘Stop’ button is selected or the video reaches the maximum 

frames (if selected) or the maximal size (MB).   

 

Warning – If the video is not closed off correctly, the video will be unable to be opened 

within Quintic software. This error occurs when the user clicks ‘record’ then ‘close’ rather 

than ‘stop’. Close should only be pressed once the stop button has been pressed, this is 

to correctly end the video.  

 

To play the video within the Quintic software, the capture window must first be closed. 

To close the capture window after the video has been captured, click on the ‘Exit’ 

button.  



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

NB: Do not use commonly unaccepted symbols such as ‘&’ or ‘/’as this may result in the 

file not saving correctly.  

 

 

 

 

 

 

Max Frames: If 

selected, the user 

can set the number 

of frames after 

which recording will 

stop automatically. 

File: Name of the 

AVI being recorded 

Current MB: 

Indicates the current 

AVI file size.  

Calc. Frame Rate: If 

selected, the frame rate of 

the video is determined 

automatically during 

recording. Quintic 

recommend keeping this 

selected.  

Maximal MB: Sets 

the maximum size 

(MB) of the AVI File. 

Recording stops 

when the AVI file 

reaches this size. 

Saved: Indicates 

number of 

frames saved to 

the AVI file. 

Received: 

Indicates number 

of frames 

transferred. 

Dropped: 

indicates number 

of dropped 

frames during 

capture.  

JPEG Quality: Sets the JPEG 

compression level, 1 = lowest 

quality/highest compression, 100 = 

highest quality/lowest compression. 

Quintic recommend a setting of 75, 

as going higher than this value may 

result in dropped frames.  



 

 

JPEG Quality – As mentioned above, the JPEG Quality function controls the 

compression level, 1 = lowest quality/highest compression, 100 = highest quality/lowest 

compression. Quintic recommend a setting of 75, as going higher than this value may 

result in dropped frames. 

 

 

The size of the file seems to exponentially increase with the quality you select within 

MJPEG compression, this increase is constant no matter how many frames in the video. 

 

 

 

 

 

 

 

 

 

 

 



 

 

2. Dual/Multi High-Speed Capture 

For installation details, please refer to Tutorial 6a - High-Speed Camera Set-up. 

The way in which the Dual / Multi High-Speed Capture works is by reading Cam files from 

a specific folder location on your machine.  

This location is as follows:  

(C:) Drive > Program Files (x86) > Quintic > Camera > Dual HS Capture OR Multi HS 

Capture  

Dual HS Capture Example  

 

 

Multi HS Capture Example 



 

 

a. Pre-Determined Cam Files 

As you will see, we have our own pre set Cam files which you are more than welcome to 

use. Simply click on the desired folder of your camera (GigE/USB2/USB3 1MP) which will 

bring up all of our pre set cam files.  

Within each folder (e.g. 100 fps 752 x 480) there are the required Cam files for 1 to 6 

cameras (Cam1, Cam2, Cam3, Cam4, Cam5, Cam6). Simply copy the required amount of 

Cam files for the number of cameras that you are using at one time.  

Once copied please paste the Cam files into the same location as mentioned earlier, which 

is:  

(C:) Drive > Program Files (x86) > Quintic > Camera > Dual HS Capture OR Multi HS 

Capture  

It may bring up a pop-up window asking to overwrite the existing cam files in this location -  

please do this. It is recommended to take a copy of the original cam files from this location 

first so they are not lost.  

Please note: All six cameras need to have the same frame speed, along with the 

characteristics mentioned under the heading ‘H. Cam Files’ above within each .ini cam file 

(Cam1.ini / Cam2.ini / Cam3.ini / Cam4.ini / Cam5.ini / Cam6.ini) in order for the multi 

camera capture software to pick up the cameras.  

b. Custom Cam Files 

The user is also able to use their own custom cam files. For more information on how to 

create these, please see above ‘Single High Speed capture’. All that would be required is 

the cam files to be renamed Cam1, Cam2 (and sequentially) for how many Quintic 

Cameras you are using at once.  

Once renamed, please copy, paste these into the required location: 

(C:) Drive > Program Files (x86) > Quintic > Camera > Dual HS Capture OR Multi HS 

Capture  

It may bring up a pop-up window asking to overwrite the existing cam files in this location -  

please do this. It is recommended to take a copy of the original cam files from this location 

first so they are not lost. 

Please note: All six cameras need to have the same frame speed, along with the 

characteristics mentioned under the heading ‘H. Cam Files’ above within each .ini cam file 

(Cam1.ini / Cam2.ini / Cam3.ini / Cam4.ini / Cam5.ini / Cam6.ini) in order for the multi 

camera capture software to pick up the cameras.  

 



 

 

Quintic Coaching & Biomechanics Only 

From the ‘Camera’ tab select ‘High Speed Capture’ then ‘Multi’. 

 

 

 

 

 

 

 

 

 

  

It is possible to pause and continue, or 

stop recording.  

 

It is possible to change the Camera exposure 

time using the slider bar should you require. 

 

 

Select the destination folder you wish to save 

the video files into, enter a file name, and start 

recording. This is recommended to be a 

physical drive on the PC (i.e C / D Drives etc). 

  

 

If you are using an IR ring light you 

can control this here. 

 

 



 

 

Select the destination folder you wish to save the video files into, enter a file name, and 

start recording. It is possible to pause and continue, or stop recording.  

NB: Do not use commonly unaccepted symbols such as ‘&’ or ‘/’as this may result 

in the file not saving correctly.  

It is possible to change the Camera exposure time using the slider bar should you require. 

Once recorded, please return to the Quintic Coaching or Biomechanics main tab and click 

on the ‘Open Video File’ button within the Main tab to view your recorded videos. 

Using v21/v26/v29/v31/v33/v35, if you open *Cam1.avi within the main window and you 

have the correct amount of windows open for the videos you recorded within that cam set 

(i.e two windows open if you recorded two cameras at once) you will have the option to 

open all the camera views, and they will automatically be synchronised.  

 

 

 

Users have the option to turn off the information box asking whether they would like to 

open the videos across all windows. This can be done by going to the help tab > > help 

menu > settings > Load Multi Cam Video Set > then choosing either: 

Always Load – Once selected this will automatically load the associated videos within the 

multi camera video set, if Cam1 is opened within the main window and the appropriate 

number of windows are open within Quintic.  

Always Ask – This will always ask whether the user would like the multi camera video files 

should be opened or not.  

Never Load – The multi camera video files will never be automatically loaded.  

 

 

 

 

 

 



 

 

Below highlights an example of a 6-camera set opened within Quintic Biomechanics 

software.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Frames Delivered – How many frames have been recorded within the video file.  

 

Images Dropped – How many frames have been dropped within the video file. 

 

Frame Rate – The frames per second of the video being recorded.  

  



 

 

3. Infrared (IR) LED Ring Light Set-up  

Infrared (IR) light is a form of electromagnetic radiation which sits outside of the 

wavelength of that of visible light, and thus cannot be detected by the human eye. 

IR is responsible for most of thermal radiation and is emitted and absorbed by molecules. 

It is used in many different applications such as industrial, scientific and medical, as well 

as in night vision equipment where is it important that the observer is not detected. We 

have utilized the properties of IR light, thus ensuring that the reflective markers are still 

visible to the camera, even though to the naked eye there is no light emitted. This we feel 

is very important when working in close proximity to the cameras (i.e. athletes are not 

“blinded” by spotlights).  

 

The following information will guide you through how to set up and configure your IR LED 

Ring light to work with Quintic. 

Connect the IR LED Ring light and the Quintic High-Speed camera via the power supply 

provided.  Connect the camera to your computer as normal, and open up the Quintic 

software. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Check the lights on the back of the high-

speed camera are flashing to ensure it is 

connected and powered properly. 

Additionally, check there is a green light 

illuminated on the side of the Quintic IR 

LED Ring Light. 



 

 

1. Open up the ‘Single High-Speed Capture’ window under the ‘Camera’ tab as 

normal.  

2. Click on the ‘Camera Properties’ button.  

 

 

 

 

 

 

 

 

 

 

 

 

3. Click the ‘Input/Output’ tab on the camera window that appears. 

 



 

 

 

4. The following screen will appear. This is where the LED light is controlled.  

 

 

 

 

 

 

 

 

 

5. Click on the setting ‘Flash High Active’. You will notice (as shown in the screenshot 

above) that the image will flash once. This confirms that the LED light is now turned 

on. 

 

6. You then need to adjust the ‘Flash Delay’ slider. You will notice that the markers 

will start to flicker, and the further you move the slider to the right, the more 

frequently it flashes. In order for the markers to reflect continuously, you must keep 

moving the slider right until the markers no longer flash. 

 

7. Once the flash delay slider is set so as the markers are no longer flashing, click 

‘Close’. 

 

8. You can now record as normal, and the markers should be clearly visible. 

N.B. The Flash Delay value you need to set the IR LED Ring Light at to keep the 

markers constantly illuminated depends upon the frame speed the camera is set to. 

You need to match up the frame speed of the camera to the frequency of the LED 

so that they are pulsing at the same time. Below are some examples of different 

frame speeds. 

N.B. If you are using Multi Camera High- Speed capture, you will need to save the 

camera parameters as ‘Cam1’, ‘Cam2’, etc. to ensure that the LED remains on 

during Multi camera capture. To do this, click ‘File’, ‘Save camera parameters’ (as 

outlined above within the ‘Single High Speed Capture’.  Save these to the desktop 



 

 

first, then copy into: C:\Program Files (x86) \ Quintic \ Camera \ Multi HS 

Capture. 

When using the IR LED Ring Light users are required to create their own cam files so 

that the camera is able to be synchronised with the light.  

 

Frame Speed: 100 fps; Flash Delay: 9606 μs 

 

If the camera is already running at it’s maximum frame speed, you may need to adjust 

the size of the image / the area of interest in order to increase the frame speed. The 

window for this is shown below. 

 

 

 

 



 

 

 

Frame Speed: ≈ 125 fps; Flash delay: 7587 μs 

 

 

Frame Speed: 200 fps; Flash delay: 4810 μs 

 

 


